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Preface

This guide describes how to configure the Thermo EASY-nLC™ instrument control software 
from the Thermo Foundation™ platform, set up the liquid chromatography (LC) parameters 
for LC/MS instrument methods in the Instrument Setup window of the Thermo Xcalibur™ 
data system, and set up the sample position settings and injection volumes for an injection 
sequence from the Sequence Setup view in the Xcalibur data system.

Related Documentation
For the EASY-nLC instrument, Thermo Fisher Scientific provides these manuals as PDF files:

• EASY-nLC Series Preinstallation Requirements Guide

• EASY-nLC Series Getting Started Guide (using the stand-alone, touch-screen application)

• EASY-nLC Series Troubleshooting and Maintenance Guide

• EASY-nLC Series User Guide for the Xcalibur Data System

The data system also provides Help for the EASY-nLC VI control software.

 To view the EASY-nLC manuals

Choose Start > Programs (or All Programs) > Thermo Instruments > Manuals > 
LC Devices > Thermo. 

IMPORTANT      To establish communication with the EASY-nLC instrument and to avoid 
the premature termination of data acquisition during sequence runs, set up the data 
system computer as described in “Data System Computer Settings” on page viii.

Contents

• Related Documentation

• System Requirements

• Data System Computer Settings

• Safety and Special Notices

• Contacting Us
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Preface
 To open Help

• From the Thermo EASY-nLC view of the Instrument Setup window, choose one of 
the following:

– Help > Thermo EASY-nLC Help to open the Welcome page of the Thermo 
EASY-nLC Help

– Help > Help On Current Item F1 to open the Help topic for the current page of 
the Thermo EASY-nLC view of the Instrument Setup window

• Press the F1 key to open the Help topic for the Thermo EASY-nLC Configuration 
dialog box of the Thermo Foundation – Instrument Configuration window or a 
specific page of the Thermo EASY-nLC view of the Instrument Setup window. 

 To copy manuals from the Internet

1. Go to mssupport.thermo.com.

2. On the Terms and Conditions page, click I Agree.

3. Click Customer Manuals in the left margin of the window.

A documents list appears.

4. Click Search in the right margin of the window.

The search options appear.

5. Select the following:

• Model: EASY-nLC 

• Document Type: Manual

6. Click Submit Search.

A list of EASY-nLC manuals appears.

7. Select the appropriate manual.
vi EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific
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Preface
System Requirements
These are the system requirements for the EASY-nLC device driver. This device driver is 
provided on the LC Devices 2.5.0 or later DVD and is designed for use with the 
Thermo Xcalibur 2.1 or later data system or an equivalent Thermo Scientific mass 
spectrometry application.

Table 1 lists the data system computer hardware and software requirements. 

IMPORTANT       Before you install the device driver provided on the LC Devices DVD, 
ensure that the data system computer has a compatible version of the 
Thermo Foundation™ platform as noted in the Thermo LC Devices x.x.x Release Notes, 
where x.x.x is the version you want to install. You can find the Release Notes document, 
which includes the system requirements, on the LC Devices DVD. 

Table 1. Data system computer hardware and software requirements

System Requirements

Data system computer
(minimum 
requirements)

• 2 GHz processor with 1 GB RAM 
• DV-Rom drive 
• 80 GB hard drive capacity
• Display resolution 1280 × 1024 resolution 
• 2 Network cards 
• NTFS format 

Operating system Microsoft™ Windows™ operating system: 

• Windows 7 Professional (32-bit and 64-bita) 

–or–

• Windows XP Workstation SP3 

a LC Devices 2.8.0 or later is compatible with Windows 7, 32-bit and 64-bit 

Third-party software Adobe™ Reader™ 9.0 or later

Thermo Scientific 
software

LC Devices Foundation platform

2.8.0 1.0.2 SP2 or later

2.7.0 1.0.2 SP2 or 2.0.0 SP1

2.6.0 2.0.0 or 2.0.0 SP1 

2.5.0 SP3 1.0.2 SP2 with QF 10402

2.5.0 SP2 2.0.0 or 2.0.0 SP1

2.5.0 SP1 2.0.0

2.5.0 1.0.0, 1.0.1, or 1.0.2 
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System vii



Preface
Data System Computer Settings
Table 2 lists the virus scanner setting that is required to establish communication with the 
EASY-nLC instrument and the computer settings that are required to avoid the premature 
termination of data acquisition during sequence runs.

IMPORTANT      After you install the Thermo EASY-nLC device driver on a Windows 7 
computer, exclude the Thermo EASY-nLC software from the Prevent IRC 
Communication list for the computer’s virus scanner as described in “Excluding the 
EASY-nLC from the VirusScan Enterprise” on page 5.  If you do not exclude the Thermo 
EASY-nLC software, the data system computer cannot establish communication with the 
EASY-nLC instrument.

Table 2. Data system computer settings

Category Settings

Power saver • Screen saver: None
• Hibernate: Not enabled or Never
• Turn off hard disk: Never
• Turn off monitor: Never

Windows updates If the data system computer is connected to the Internet, turn 
off the automatic Windows updates.

Virus scanner For the Windows 7 operating system, exclude the 
Thermo EASY-nLC software from the virus scanner 
(see “Excluding the EASY-nLC from the VirusScan 
Enterprise” on page 5).
viii EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



Preface
Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes. Safety and special notices include the following.

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

 To contact Technical Support for the EASY-nLC instrument

Find software updates and utilities to download at mssupport.thermo.com.

 To order consumable and spare parts for the EASY-nLC instrument

• For the EASY-nLC 1000 instrument, go to:

www.proxeon.com/productrange/nano_lc_easy-nlc_1000/accessories_spares/index.html

• For the EASY-nLC II instrument, go to:

www.proxeon.com/productrange/nano_lc/accessories-spares/index.html

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT      Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

Web site www.proxeon.com

E-mail (North and South America) 
us.customer-support.analyze@thermofisher.com
(Other continents)
eu.techsupport.cmf@thermofisher.com

Address Thermo Fisher Scientific
Edisonvej 4
DK-5000 Odense C
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1

Installing the EASY-nLC Control Software

To install the EASY-nLC instrument control software from the LC Devices DVD, follow 
these instructions. After you install the EASY-nLC instrument control software onto the data 
system computer, make sure that you exclude the EASY-nLC software from the McAfee™ 
VirusScan™ Enterprise software.

Prerequisites
Before installing the EASY-nLC VI control software, do the following:

• Install compatible versions of the Thermo Foundation platform and the Xcalibur data 
system (or equivalent Thermo Scientific data system).

• Ensure that you have administrator rights to install the EASY-nLC VI control software for 
the Xcalibur application.

• Remove any earlier version of the EASY-nLC VI control software from the data system 
computer (see “Removing a Previous Version of the Instrument Control software” on 
page 2).

Contents

• Prerequisites

• Removing a Previous Version of the Instrument Control software

• Installing the Current Version of the Instrument Control Software

• Excluding the EASY-nLC from the VirusScan Enterprise
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1 Installing the EASY-nLC Control Software
Removing a Previous Version of the Instrument Control software
Before or after installing the EASY-nLC VI control software, do the following:

• Connect the EASY-nLC instrument to the data system computer through an Ethernet 
connection (see “Connecting the EASY-nLC Instrument to the Data System Computer” 
on page 7).

• Connect the EASY-nLC instrument to the Thermo Scientific MS detector with a contact 
closure cable. 

The data system synchronizes the run timing between the LC system and the mass 
spectrometer through the cable. For information about connecting the contact closure 
cable, refer to the EASY-nLC Series Getting Started Guide.

• Check the laboratory local area network (LAN) port for Internet access to the remote 
support server. For remote diagnostics, the laboratory must have a LAN port with 
Internet access. 

The network firewall must allow outgoing Transmission Control Protocol/Internet 
Protocol (TCP/IP) traffic from the EASY-nLC instrument to the remote support server at 
IP address 195.41.108.93, port 22.

After installing the EASY-nLC VI control software, exclude the software from the virus 
scanner as described in “Excluding the EASY-nLC from the VirusScan Enterprise” on page 5.

Removing a Previous Version of the Instrument Control software
 To remove a previously installed version of the EASY-nLC Xcalibur VI

1. Depending on the Windows operating system, do one of the following:

• For Windows 7, choose Control Panel > Uninstall a Program.

The list of installed programs appears (see Figure 1).

• For Windows XP, choose Start > Settings > Control Panel > Add or Remove 
Programs. 
2 EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



 1 Installing the EASY-nLC Control Software
Removing a Previous Version of the Instrument Control software
Figure 1. Uninstall window for the Windows 7 operating system

2. In the list of installed programs, locate Thermo LC Devices Thermo EASY-nLC 
Xcalibur VI. 

3. Depending on the operating system, do one of the following:

• For Windows 7, double-click Thermo LC Devices Thermo EASY-nLC Xcalibur VI 
or click Uninstall. Wait for the program to be removed from the list.

• For Windows XP, click Remove (see Figure 2). Wait for the program to be removed 
from the list.

Figure 2. Add or Remove Programs window for the Windows XP operating system
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System 3



1 Installing the EASY-nLC Control Software
Installing the Current Version of the Instrument Control Software
Installing the Current Version of the Instrument Control Software
 To install the EASY-nLC Virtual Instrument software

1. Check the installed versions of the Foundation application and the Xcalibur data system 
and make sure that these versions are compatible with the LC Devices version that you are 
installing (see “System Requirements” on page vii).

2. Close all running programs before starting the installation. 

3. If applicable, remove the previously installed version of the EASY-nLC VI software 
(see “Removing a Previous Version of the Instrument Control software” on page 2).

4. Load the LC Devices DVD into the data system computer, and follow the instructions in 
the Thermo LC Devices InstallShield Wizard. 

5. On the Select Features page of the wizard, select the Thermo check box on the left, and 
then select the Thermo EASY-nLC Xcalibur check box on the right (see Figure 3).

Figure 3. Select Features page of the Thermo LC Devices InstallShield Wizard

6. When the installation finishes, restart the data system computer.

The installation is complete when you log back in.
4 EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



 1 Installing the EASY-nLC Control Software
Excluding the EASY-nLC from the VirusScan Enterprise
Excluding the EASY-nLC from the VirusScan Enterprise 
The McAfee virus scanner blocks the Thermo EASY-nLC software when the data system 
computer uses the Windows 7 operating system.

 To exclude the EASY-nLC software from the VirusScan Enterprise 8.7.0i

1. Log in to the data system computer as an administrator.

2. Open the McAfee VirusScan Console as follows:

a. Do one of the following:

• On the Windows 7 taskbar, right-click the McAfee icon, , and choose 
Manage Features > VirusScan Enterprise.

–or–

• From the Windows 7 desktop, choose Start > All Programs > McAfee > 
VirusScan Console.

The VirusScan Console opens.

3. In the Task column, right-click Access Protection and choose Properties from the 
shortcut menu.

The Access Protection Properties dialog box appears.

4. To open the Rules dialog box, do the following:

a. Under Categories, choose Anti-virus Standard Protection.

b. Under Rules, select Prevent IRC Communication.

c. Click Edit.

The Rules Details dialog box opens.

IMPORTANT      For the Windows 7 operating system, you must exclude the EASY-nLC 
VI software from the McAfee blocking list. For the Windows XP operating system, 
exclude the EASY-nLC VI software from the McAfee blocking list only if the EASY-nLC 
instrument is experiencing communication problems.
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System 5



1 Installing the EASY-nLC Control Software
Excluding the EASY-nLC from the VirusScan Enterprise
5. Modify these settings:

• In the Processes to Include box, delete the asterisk.

• In the Processes to Exclude box, type Thermo*.

6. Click OK to close the Rules Details dialog box.

7. Click OK to close the Access Protection Properties dialog box and accept the new 
settings. 

8. Close the VirusScan Console.

Note  When the Processes to Include box contains only a single asterisk, the virus 
scanner prevents IRC communication for all processes.

Note  When the Processes to Exclude box contains the text Thermo*, the Access 
Protection service for Internet Relay Chat (IRC) communication processes 
ignores processes that begin with Thermo.
6 EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



2

Setting Up the Software Instrument Configuration

Use the EASY-nLC view of the Thermo Foundation Instrument Configuration window to set 
up and test the network connection for the EASY-nLC instrument, to specify the tray type 
that you plan to use, and to identify the mobile phase solvents in solvent reservoir bottles A 
and B. 

Before you set up the instrument configuration, connect the EASY-nLC instrument to the 
data system computer, turn on the EASY-nLC instrument, and log in to the instrument as an 
administrator.

Connecting the EASY-nLC Instrument to the Data System Computer
The EASY-nLC instrument and the Thermo Scientific mass spectrometer communicate with 
the data system computer through an Ethernet connection routed through an Ethernet switch 
connected to the data system computer. 

These are the default IP addresses of the data system computer and the EASY-nLC 
instrument.

Contents

• Connecting the EASY-nLC Instrument to the Data System Computer

• Adding the System Devices to the Instrument Configuration

• Setting Up the EASY-nLC Configuration

• Setting Up the Sample Layout and Start Position

Table 3. Default IP addresses for the LC system

System module IP address

Data system computer 172.16.0.101

EASY-nLC instrument 172.16.0.103
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2 Setting Up the Software Instrument Configuration
Adding the System Devices to the Instrument Configuration
 To connect the EASY-nLC instrument to the data system computer

1. Connect a shielded Ethernet cable to the LAN port on the back panel of the EASY-nLC 
instrument. 

2. Connect the other end of the Ethernet cable to an Ethernet switch.

3. Using a second shielded Ethernet cable, connect the Ethernet switch to the appropriate 
network card installed in the data system computer.

For more information about setting up the communication cables, refer to the EASY-nLC 
Series Getting Started Guide.

Adding the System Devices to the Instrument Configuration
Your Thermo Scientific LC/MS system consists of a Thermo Scientific mass spectrometer and 
an EASY-nLC instrument. To control these instruments from the Xcalibur data system, you 
must add the installed device drivers to the instrument configuration.

 To add devices to the instrument configuration

1. From the Windows taskbar, choose Start > Programs (or All Programs) > 
Thermo Foundation  x.x > Instrument Configuration, where x.x is the installed version 
of Thermo Foundation.

The Thermo Foundation Instrument Configuration window opens (see Figure 4). The 
installed devices are listed in the Available Devices list. The configured devices are listed 
in the Configured Devices list.

Figure 4 shows an instrument configuration with a Thermo Scientific mass spectrometer 
added to the Configured Devices list.

IMPORTANT      Avoid IP conflicts with other units on the network, especially the 
mass spectrometer. 
8 EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



 2 Setting Up the Software Instrument Configuration
Adding the System Devices to the Instrument Configuration
Figure 4. Thermo Foundation Instrument Configuration window

2. Add the EASY-nLC instrument to the instrument configuration as follows:

a. Make sure that the Device Types list is set to All or AS (AutoSampler). 

If the Device Type list is set to LC, the EASY-nLC VI for Xcalibur device does not 
appear in the Available Devices list.

b. In the Available Devices list, double-click the Thermo EASY-nLC icon. 

A copy of the Thermo EASY-nLC icon appears in the Configured Devices list.

3. Set up the configuration options for each configured device. 

For information about the EASY-nLC configuration parameters, see the next topic, 
“Setting Up the EASY-nLC Configuration.” 

4. Click Done to close the Thermo Foundation Instrument Configuration window.

Tip  To access Help, press F1 or click Help.

Tip  You must close the Instrument Configuration window before you open the 
Xcalibur data system. The two applications cannot be open at the same time.
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System 9



2 Setting Up the Software Instrument Configuration
Setting Up the EASY-nLC Configuration
Setting Up the EASY-nLC Configuration
Use the Thermo EASY-nLC Configuration dialog box to set up and test the communication 
connection to the data system computer, to specify the autosampler model and the plate type 
that you are using, and to identify the mobile phase solvents. Clicking the Edit button in the 
Autosampler Configuration area opens the Sample Position Selector dialog box where you set 
up the sample layout (row first or column first) and the start position for an Xcalibur injection 
sequence.

For information about opening the Thermo Foundation Instrument Configuration window 
and adding the EASY-nLC device driver to the instrument configuration, see “Adding the 
System Devices to the Instrument Configuration” on page 8.

 To set up the EASY-nLC configuration

1. In the Configured Devices list of the Thermo Foundation Instrument Configuration 
window, double-click the Thermo EASY-nLC icon. 

The Thermo EASY-nLC Configuration dialog box opens (see Figure 5).

Figure 5. Thermo EASY-nLC Configuration dialog box
10 EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



 2 Setting Up the Software Instrument Configuration
Setting Up the EASY-nLC Configuration
2. Ensure the following:

• The EASY-nLC instrument is connected to the data system computer by way of an 
Ethernet switch (see “To connect the EASY-nLC instrument to the data system 
computer” on page 8). 

• The EASY-nLC instrument is turned on, and you are logged in as an administrator to 
the instrument.

3. Set up the network configuration for the EASY-nLC instrument as follows:

a. Type the IP address of the EASY-nLC instrument and your user name in the 
appropriate boxes. 

You must have an account on the EASY-nLC instrument with the same user name. 
The default user name is “admin,” but you can change this to any existing user 
account on the EASY-nLC instrument. 

b. Click Test Connection to test the connection to the EASY-nLC instrument and to 
download the instrument configuration information to the data system computer. 

4. Check the message in the status box to the right of the Test Connection button.

• If the connection is established, the status box changes to green (see Figure 6) and the 
information about the LC device driver and instrument appears.

• If a connection is not established, the status bar changes to red. Check the Ethernet 
cable connections, the IP address of the EASY-nLC instrument, and the IP address of 
the network card installed in the data system computer (see “Connecting the 
EASY-nLC Instrument to the Data System Computer” on page 7).

• If an antivirus program or firewall blocks the connection, the application displays this 
error message:

An established connection was aborted by the software in your host machine.

Contact your local IT administrator for assistance. 

For information about excluding the EASY-nLC software from the McAfee virus scanner, 
see “Excluding the EASY-nLC from the VirusScan Enterprise” on page 5.

5. Check the instrument information. If necessary, change the instrument information as 
described in “To change the loop volume, column setup, idle mixture, or idle flow rate” 
on page 13.

Tip  The EASY-nLC IP address is listed in the About box, which you can open by 
pressing the THERMO logo in the upper left corner of the touch screen. The 
current user is listed in the lower left corner of the touch screen.

If necessary, change the IP address on the Configuration > Network page of the 
touch-screen software. 
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System 11



2 Setting Up the Software Instrument Configuration
Setting Up the EASY-nLC Configuration
6. Set up the autosampler configuration in the Autosampler Configuration area as follows:

a. Select the autosampler model (Autosampler ASA or Autosampler ASC).

b. Select the plate type (96- or 384-well plates, or a 4 × 6 (ASA) or 6 × 8 (ASC) vial 
holder).

Figure 6. Thermo EASY-nLC Configuration dialog box

c. (Optional) Set up the default sample layout and start position to be used when 
creating a new Xcalibur sequence as described in Setting Up the Sample Layout and 
Start Position.

7. In the Solvents for LC Pump area, type the names of the solvents in the boxes for solvent 
bottles A and B.

Solvent bottle A typically contains LC/MS-grade water with 0.1% formic acid. Solvent 
bottle B typically contains LC/MS-grade acetonitrile with 0.1% formic acid.

Note  All plate formats for the ASC model have six extra vial positions 
on the side. When you set up an Xcalibur sequence, these vials are numbered 
1-V1 to 1-V6.

Edit button

Touch-screen 
software version 3.1
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 2 Setting Up the Software Instrument Configuration
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8. If the OK button is unavailable, click Test Connection to download the new 
configuration settings to the data system computer.

9. Click OK to accept the settings and close the Thermo EASY-nLC Configuration dialog 
box.

10. Click Done to close the Thermo Foundation Instrument Configuration application.

You must close the Foundation application before opening the Xcalibur data system. The 
Xcalibur data system and the Thermo Foundation Instrument Configuration window 
cannot be open at the same time.

 To change the loop volume, column setup, idle mixture, or idle flow rate

1. From the instrument’s touch screen, do the following:

a. Open the Maintenance > Devices page.

b. In the Devices list, select EASY-nLC, and then press the Properties tab.

c. Change one or more of these items:

• Loop Volume. Type the nominal volume of the sample loop installed on valve S 
(5, 20, or 50 μL).

• Idle Flow Rate. 

• Idle Mixture %B. Type a value from 0 to 100.

• Column Setup. Select or clear the One Column Setup check box. 

• Load Speed Protection (LSP). Select or clear the LSP check box (touch-screen 
software version 3.0 or later).

d. Click Apply.

2. In the EASY-nLC Configuration dialog box, click Test Connection. Then verify the new 
settings.

EASY-nLC Configuration Dialog Box Parameters

When you establish a connection between the EASY-nLC instrument and the data system 
computer, this dialog box displays the user-specified loop volume, idle flow rate, idle mixture, 
and column setup. You set these parameters from the EASY-nLC touch-screen software, not 
the Xcalibur instrument control software. See “To change the loop volume, column setup, idle 
mixture, or idle flow rate,” for information about changing these settings.
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Table 4 describes the parameters in the Thermo EASY-nLC Configuration dialog box. 

Table 4. EASY-nLC Configuration dialog box parameters (Sheet 1 of 2)

Parameter Description

EASY-nLC Network Configuration

Use this area to specify the IP address for the EASY-nLC instrument.

IP Address/Hostname Specifies the IP address of the EASY-nLC instrument. This value must match the value 
stored by the instrument.

Tip  To check the IP address and host name stored by the instrument, press the company 
logo in the upper-left corner of the EASY-nLC touch screen.

User Name Specifies the user name. 

Note  The user name that you type in this box must match the user name for the person 
currently logged in to the instrument. The user name is listed in the lower-left corner of 
the EASY-nLC touch screen. For information about logging in to the EASY-nLC 
instrument, refer to the EASY-nLC Series Getting Started Guide.

Test Connection 
button

Tests the Ethernet connection between the data system computer and the EASY-nLC 
instrument. If the connection is established, the status box to the right of the button turns 
green and contains this message: Connection OK.

In addition, the LC device driver and instrument information appears in the box below the 
status bar.

IMPORTANT      If the following message appears, exclude the Thermo EASY-nLC 
software from the McAfee virus scanner as described in “Excluding the EASY-nLC from 
the VirusScan Enterprise” on page 5:

An established connection was aborted by the software in your host machine.

Contact your local IT administrator for assistance.

LC Device Driver and Instrument Information

LC Device Driver Displays the LC device driver version.

LC Instrument Displays the instrument type.

Driver Info Displays the instrument’s touch-screen software version.

Serial Number Displays the serial number that is listed on the instrument’s back panel.

Loop Volume Displays the user-specified loop volume stored by the EASY-nLC instrument.

Idle Flow Rate Displays the user-specified idle flow rate that the instrument maintains at the end of an 
injection sequence.

Entering a value of 0 deactivates this feature.

Tip  Maintaining long-term emitter stability (with glass emitters) might require a constant 
solvent flow through the system. 
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Idle Mixture Displays the user-specified solvent composition (%B) that the instrument is to pump 
through the system at the end of an injection sequence.

Column Setup Displays the user-specified selection. Displays One Column or Two Column.

IFC Displays whether the intelligent flow control (IFC™) mode is enabled. The IFC mode is a 
user-selectable option in the touch-screen software version 2.8. 

Max Pressure Displays the maximum system pressure.

Autosampler Configuration

Use this area to select the autosampler type, plate type, sample layout, and initial vial position.

Autosampler Specifies the autosampler model:

• ASC—Autosampler with refrigerated compartment and 6 extra vials

• ASA—Autosampler with a cooled plate and without the 6 extra vials

Plate Installed Specifies the plate type that you plan to use: 96 well plate, 384 well plate, or 6 × 8 vial plate.

Sample Layout Displays the default sample layout (vial or microplate well positions) for an injection 
sequence.

Start Position Displays the default initial sample position for an injection sequence.

Edit button Opens the Sample Position Selector dialog box where you can select the sample layout and 
initial position for an Xcalibur sequence (see “Setting Up the Sample Layout and Start 
Position” on page 16).

Solvents for LC Pump

Use this area to describe the solvents that make up the gradient.

A Specifies the solvent in solvent bottle A.

B Specifies the solvent in solvent bottle B. 

Table 4. EASY-nLC Configuration dialog box parameters (Sheet 2 of 2)

Parameter Description
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Setting Up the Sample Layout and Start Position
When you open the Sample Position Selector dialog box from the Thermo EASY-nLC 
Configuration dialog box, the Number of Samples to Select box and the Select button are 
unavailable. 

When setting up the configuration options for the EASY-nLC instrument, use the Sample 
Position Selector dialog box to set up the sample layout and initial vial or microplate well 
position for an injection sequence. 

For information about using the Sample Position Selector dialog box to interactively select the 
vial or microplate well positions for an injection sequence, see “Setting Up the Injection 
Positions with the Sample Position Selector” on page 40.

 To set up the sample layout and start position for an Xcalibur injection sequence

1. In the Autosampler Configuration area, click Edit.

The Thermo EASY-nLC Sample Position Selector dialog box opens. The Number of 
Samples to Select box is unavailable (see Figure 7).

Figure 7. Sample Position Selector dialog box

2. In the Sample Positions area, click Clear All.

3. In the Plate Rack area, select the default initial sample position by clicking a position.

4. In the Sample Selection Layout area, select the Row First or Column First option. 
16 EASY-nLC User Guide for the Xcalibur Data System Thermo Scientific



 2 Setting Up the Software Instrument Configuration
Setting Up the Sample Layout and Start Position
5. Click OK to save your changes and exit the Thermo EASY-nLC Sample Position Selector 
dialog box.

Sample Position Selector Dialog Box Parameters

Table 5 describes the parameters in the Sample Position Selector dialog box. When you access 
this dialog box from the EASY-nLC Configuration dialog box, only the Sample Position 
Layout and Initial Position parameters are available. 

Note  You can also open the Thermo EASY-nLC Sample Position Selector dialog box 
by clicking Select Vials in the Samples area of the Xcalibur New Sequence Template 
dialog box (see Figure 12 on page 36). 

Table 5. Sample Position Selector dialog box parameters

Parameter Description

Plate Rack

Use this area to select or clear the sample positions. 

Vial Rack

For an EASY-nLC instrument with an ASC model autosampler (standard in the EASY-nLC 1000 instrument), you 
can select or clear a sample position from the additional 6 vials.

Note  The additional vials are located on rack 1 and are called 1-V1 to 1-V6.

Sample Selection Layout

Row First When you select the Row First option, the data system fills the sequence table with the 
sample positions row by row.

Column First When you select the Column First option, the data system fills the sequence table with the 
sample positions column by column.

Note  The sequence editor ignores the Sample Selection Layout option when you select 
the vial or well positions by clicking a set of samples in the Plate and Vial Rack areas.

Sample Positions (click on plate)

Initial Position Specifies the first vial or microplate well position in the sequence table.

Number of Samples to 
Select

Specifies the number of samples to add to the sequence table in addition to the initial vial 
position.

Clear All button Clears all of the Plate and Vial Rack entries and the Initial Position entry.

Select button Sequentially selects the number of vial or well positions specified in the Number of Samples 
to Select box. The selected vials or wells are highlighted in green in the Plate Rack and Vial 
Rack areas. The vials or wells are ordered sequentially according to the sample selection 
layout selection.

Dialog box buttons

OK Accepts the settings and closes the dialog box.

Cancel Closes the dialog box without accepting the changes.
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Creating Xcalibur Instrument Methods

An Xcalibur instrument method (.meth) contains the chromatographic and data acquisition 
parameters for your LC/MS system. When creating new instrument methods, set up the 
parameters for all of the configured devices.

To create instrument methods for a Thermo Scientific LC/MS system with an EASY-nLC 
instrument, follow these instructions.

Note  For information about setting up the instrument method parameters for the mass 
spectrometer, refer to the Help for the mass spectrometer.

Contents

• Setting Up the EASY-nLC Instrument Method Parameters

• Saving Instrument Methods
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System 19



3 Creating Xcalibur Instrument Methods
Setting Up the EASY-nLC Instrument Method Parameters
Setting Up the EASY-nLC Instrument Method Parameters
Use the Instrument Setup window of the Xcalibur data system to create instrument methods 
for your LC/MS system. To create an instrument method, enter the data acquisition settings 
for the mass spectrometer and the injection and chromatographic settings for the LC system. 

For information about the pages of the EASY-nLC view, see these topics:

• “Sample Pickup and Loading Page” on page 22

• “Gradient Page” on page 24

• “Pre-Column and Analytical Column Page” on page 27

• “Auto-Sampler Page” on page 30

 To open the Instrument Setup window 

From the Xcalibur Home Page, do one of the following:

• Choose GoTo > Instrument Setup.

–or–

• Click the Instrument Setup icon in the Roadmap view of the Home Page. 

The Instrument Setup window opens. The view bar contains icons for the configured 
devices. 

 To set up the instrument method parameters for the EASY-nLC instrument 

1. In the view bar of the Instrument Setup window, click the Thermo EASY-nLC icon.

The EASY-nLC view opens in the Instrument Setup window with the Sample Pickup and 
Loading page displayed (see Figure 8). The specified mobile phase solvents are listed at 
the bottom of the window in the Solvents area.

2. Enter the appropriate instrument method settings for the EASY-nLC instrument. Click 
Next to open the remaining three pages of the EASY-nLC view page by page.
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Figure 8 shows the Sample Pickup and Loading page of the EASY-nLC view with typical 
sample pickup and loading settings for the EASY-nLC 1000 instrument and a sample in an 
aqueous matrix.

Figure 8. EASY-nLC view of the Instrument Setup window 
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Sample Pickup and Loading Page

Use the Sample Pickup and Loading page to specify the following:

• The sample volume that the autosampler withdraws (injection volume) from the vial or 
well position in the Xcalibur injection sequence and the flow rate at which the 
autosampler draws the sample into the sample loop.

• The solvent volume that pump A uses to push the sample out of the sample loop and 
onto the column assembly and the flow rate and maximum pressure for the sample 
loading step.

 To open the Sample Pickup and Loading page

1. Open the EASY-nLC view of the Instrument Setup window.

2. If the Sample Pickup and Loading page is not displayed, click the Sample Pickup and 
Loading tab.
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Sample Pickup and Loading Page Parameters

Table 6 describes the parameters on the Sample Pickup and Loading page of the EASY-nLC 
view of the Instrument Setup window.

Table 6. Sample Pickup and Loading page parameters

Parameter Description

Sample Pickup

Volume (μL) Specifies the sample volume that the autosampler withdraws from the vial or well position 
specified in the Xcalibur sequence.

Maximum volume = sample loop volume – 2 μL 

The graphic on the Home > Overview page (touch screen) displays the sample loop size. 

Flow (μL/min) Specifies the flow rate at which pump S draws the sample into the sample loop.

Range: 0 to 40 μL/min. The flow must be greater than 0 when the sample pickup volume is 
greater than 0.

Tip  For aqueous sample matrixes, set the flow rate to 20 μL/min.

Sample Loading

Volume (μL) Specifies the volume of solvent A that the instrument uses to push the sample out of the 
sample loop and onto the precolumn (two-column setup) or the analytical column 
(one-column setup).

Typically, two times the sample pickup volume plus 2 μL is sufficient.

Range: 0 to 137 μL 

IMPORTANT      The maximum allowable entry is 137 μL; however, for Xcalibur sequence 
runs, the sample loading volume plus the precolumn equilibration volume plus the analytical 
column equilibration volume must be less than 120 μL. 

See “Run-Time Error Messages” on page 44.

Flow (μL/min) Specifies the flow rate at which pump A pumps solvent A through the instrument to push 
the sample out of the loop and onto the precolumn or analytical column.

If the Flow box is empty, the instrument runs at the set pressure.

Range: 0 to 100 μL/min 

Max Pressure (bar) Specifies the maximum pressure for the sample loading step. 

If the Max Pressure box is empty, the instrument runs at the set flow rate.

EASY-nLC II range: 0 to 280 bar
EASY-nLC 1000 range: 0 to 980 bar

Tip  If both the Max Pressure and Flow boxes are empty, the instrument runs at the maximum instrument 
pressure. Leave these boxes empty if you want the instrument to run at the highest possible flow rate that is 
allowed under the maximum instrument pressure limit.
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Gradient Page

Use the Gradient page to set up the gradient program (see Figure 9).

 To open the Gradient page

1. Open the EASY-nLC view of the Instrument Setup window.

2. Click the Gradient tab. If you do not see the Gradient tab, click Next.

Figure 9. Gradient page

 To set up the gradient program

1. In the Time = 0.00 row, do the following:

• In the Flow (nL/min) column, type a value from 1 to 2000.

• In the %B column, type a value from 0 to 100.

2. To add an additional time point (table row), click Add.
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3. In rows 2 or higher of the gradient table, do the following:

a. In the Duration column, type a value from 0.01 to 9999.49.

The value in the Duration column is the length of time that you want the instrument 
to take to reach the specified flow and %B conditions. When you type a value in the 
Duration column, the value in the Time column changes to the current Duration 
value plus the value in the previous row. 

b. In the Flow (nL/min) column, type a value from 1 to 2000.

c. In the %B column, type a value from 0 to 100.

Both the flow rate and %B composition change linearly between time points.

4. Edit the table as follows:

• To delete a row, select the row and click Del.

• To reorder the rows as applicable, select the row and click Up or Down. 
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Gradient Page Parameters

Table 7 describes the parameters on the Gradient page of the EASY-nLC view in the 
Instrument Setup window.

Table 7. Gradient page parameters

Parameter Description

Table

Time Specifies the run time when the instrument reaches the conditions specified in the flow 
and %B columns.

Duration Specifies the length of time between the previous and current time points.

Range: 0.01 to 9999.59 minutes

Flow (nL/min) Specifies the mobile phase flow rate for the current time point.

Range: 1 to 2000 nL/min

%B Specifies the percent composition of solvent B in the mobile phase for the current time 
point.

Buttons

Add Adds a row to the gradient program.

Del Deletes the selected row from the gradient program.

Up Moves the selected row up.

Down Moves the selected row down.

Graph

Flow (nL/min) The y axis on the left side of the graph displays the flow scale.

A black line represents the change in flow rate with time.

AB mixture (%B) The y axis on the right side of the graph displays the percentage of solvent B.

A red line represents change in %B with time.

Time (min) The x axis displays the run time of the gradient program.
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Pre-Column and Analytical Column Page

Use the Pre-column and Analytical Column page to set up the column equilibration steps 
(see Figure 10). 

 To open the Pre-column and Analytical Column page

1. Open the EASY-nLC view of the Instrument Setup window.

2. Click the Pre-column and Analytical Column tab. If you do not see the Pre-column and 
Analytical Column tab, click Next.

Figure 10. Pre-column and Analytical Column page
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Pre-Column and Analytical Column Page Parameters

Table 8 describes the parameters on the Pre-column and Analytical Column page of the 
EASY-nLC view of the Instrument Setup window.

Note  For information about determining the appropriate flow rate for the precolumn and 
analytical column equilibration steps, refer to the EASY-nLC Series Getting Started Guide.

Table 8. Pre-column and Analytical Column page parameters (Sheet 1 of 2)

Parameter Description

Pre-column Equilibration

Volume (μL) Specifies the volume of solvent A that pump A pushes through the precolumn to waste 
during the precolumn equilibration step.

Range: 0 to 137 μL

IMPORTANT      The maximum allowable entry is 137 μL; however, for Xcalibur sequence 
runs, the sample loading volume plus the precolumn equilibration volume plus the analytical 
column equilibration volume must be less than 120 μL.

Flow (μL/min) Specifies the flow rate for the precolumn equilibration step. If the Flow box is empty, the 
instrument runs at the set pressure. 

Range: 0 to 100 μL/min 

Max Pressure (bar) Specifies the maximum pressure for the precolumn equilibration step. If the Max Pressure 
box is empty, the instrument runs at the set flow rate. 

EASY-nLC II range: 0 to 280 bar
EASY-nLC 1000 range: 0 to 980 bar

Tip  If both the Max Pressure and Flow boxes are empty, the instrument runs at the maximum instrument pressure. 
Leave these boxes empty if you want the instrument to run at the highest possible flow rate that is allowed under the 
maximum instrument pressure limit.
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Analytical Column Equilibration

Volume (μL) Specifies the volume of solvent A that pump A pushes through the analytical column during 
the analytical column equilibration step.

Range: 0 to 137 μL

IMPORTANT      The maximum allowable entry is 137 μL; however, for Xcalibur sequence 
runs, the sample loading volume plus the precolumn equilibration volume plus the analytical 
column equilibration volume must be less than 120 μL. 

See “Run-Time Error Messages” on page 44.

Flow (μL/min) Specifies the flow rate for the analytical column equilibration step. If the Flow box is empty, 
the instrument runs at the set pressure.

Range: 0 to 3 μL/min 

Max Pressure (bar) Specifies the maximum pressure for the analytical column equilibration step.

EASY-nLC II range: 0 to 280 bar
EASY-nLC 1000 range: 0 to 980 bar

Note  If both the Max Pressure and Flow boxes are empty, the instrument runs at the maximum instrument 
pressure. Leave these boxes empty if you want the instrument to run at the highest possible flow rate that is allowed 
under the maximum instrument pressure limit.

Table 8. Pre-column and Analytical Column page parameters (Sheet 2 of 2)

Parameter Description
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Auto-Sampler Page

Use the Auto-sampler page to set up the wash step for the needle and sample loop.

 To open the Auto-sampler page

1. Open the EASY-nLC view of the Instrument Setup window.

2. Click the Auto-sampler tab. If you do not see the Auto-sampler tab, click Next.

Figure 11. Auto-sampler page

 To set up the standard autosampler wash step

1. Select the Standard option.

2. In the Flush Volume (μL) box, type the volume of solvent A (from wash bottle 3) that the 
autosampler uses to flush the needle and the sample loop.

The range depends on the sample loop size (see Table 9 on page 32).
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 To set up a custom wash program

1. Select the Custom option.

The custom wash table becomes available.

2. For each row that you want to add to the program, click Add.

You can select a different wash solvent for each row.

3. Edit each row as follows:

• In the Source column, select the wash solvent source: Bottle 1, Bottle 2, or Bottle 3.

• In the Volume (μL) column, type a volume from 0 to the sample loop size plus 8 μL.

If you enter a volume that is higher than 58 μL, an Invalid Method Parameter 
message box appears and the program resets the volume to the maximum allowed. 

• In the Cycles column, type a value from 0 to 10.

IMPORTANT      The EASY-nLC tray compartment holds up to four wash bottles: 

• Bottles 1 and 2 in positions W1 and W2 can contain custom wash solvents.

• Bottle 3 in position W3 must contain solvent A.

• Bottle 4 in position W4 must contain the needle wash insert.

During a custom wash program, the autosampler does the following:

1. Empties the contents of pump S into the needle wash bottle (W4).

2. Performs the steps in the custom wash program. During each cycle, the 
autosampler draws solvent from the specified bottle, and then ejects the 
solvent into the needle wash bottle (W4).

3. Performs a final wash cycle with a preset volume of solvent A from 
bottle 3 (W3).

4. Refills pump S with solvent A from bottle 3 (W3) to be ready for the next 
injection.
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Autosampler Page Parameters

Table 9 describes the parameters on the Auto-sampler page of the EASY-nLC view of the 
Instrument Setup window. 

Table 9. Auto-sampler page parameters (Sheet 1 of 2)

Parameter Description

Standard

Standard option Selecting this option enables the standard wash option.

Flush Volume (μL) Specifies the flush volume that pump S is to push through the sample loop.

Range for the 20 μL sample loop: 30.25 to 100.75 μL
Range for the 50 μL sample loop: 60.26 to 70.75 μL

Custom

Custom option Selecting this option enables the custom wash program.

For information about the steps that the autosampler performs during a custom wash 
program, see “To set up a custom wash program” on page 31. 

Custom wash table columns

Order Defines the order of the custom wash steps. 

Source Specifies the wash solvent source for the current wash step.

Selections: Bottle 1, Bottle 2, or Bottle 3

Note  Bottles 1 and 2 contain custom wash solvents. Bottle 3 contains solvent A.

Volume (μL) Specifies the wash solvent volume for each wash cycle.

Maximum allowed volume at run time: Sample loop size plus 8 μL.

Note  The Xcalibur method editor for the EASY-nLC instrument does not know the 
configured sample loop size. When you submit a sequence with the instrument method, 
Xcalibur acquisition service validates the custom wash volumes against the configured 
sample loop size. To prevent solvent from being drawn into pump S, the program limits 
the volume to the sample loop size plus 8 μL

For information about changing the sample loop size on the Maintenance > Devices page 
of the touch-screen software, see “To change the loop volume, column setup, idle mixture, 
or idle flow rate” on page 13.

Cycles Specifies the number of wash cycles for the wash step.

Range: 1 to 10

Note  For each cycle, the autosampler draws the specified volume of wash solvent from the 
specified source into the needle, and then ejects the wash solvent into wash bottle 4 (W4).
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Saving Instrument Methods
After you set up the instrument method parameters for the LC/MS system, save the 
instrument method to an appropriate directory.

 To save your current instrument method 

1. Choose File > Save As.

The Save As dialog box opens.

2. In the File Name box, type a name for the new instrument method.

3. Click Save.

The File Summary Information dialog box opens.

4. Click OK.

Buttons

Add Adds a row to the wash program.

Del Deletes the selected row from the wash program.

Up Moves the selected row up.

Down Moves the selected row down.

Table 9. Auto-sampler page parameters (Sheet 2 of 2)

Parameter Description
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Creating and Running Sequences

To create and run sequences in the Xcalibur Sequence Setup view, follow these procedures.

Creating Sequences
In the Xcalibur data system, the table that contains the sample injection information is called 
a sequence. In addition to the data file name for each injection, the sequence must contain the 
vial or microplate well positions of the samples (unknowns, calibration standards, quality 
control check standards, and so on) in the sample set, the instrument method to be used, and 
the injection volume. You can specify a different instrument method for each injection.

 To create sequences in the Xcalibur data system

1. Do one of the following to open the Home Page – Sequence Setup view:

• From the Home Page – Roadmap view, click the Sequence Setup icon, .

• From any Home Page view, choose View > Sequence Setup View.

• From the Instrument Setup window, click the Home Page icon, , and then 
choose View > Sequence Setup View.

Contents

• Creating Sequences

• Setting Up the Injection Positions with the Sample Position Selector

• Running Sequences

• Run-Time Error Messages

Tip  You cannot change the tray type for the EASY-nLC instrument in the Sequence Setup 
view of the Xcalibur Home Page. If you choose Change > Tray Name from the menu bar, 
the following Home Page message appears: 

The configured autosampler does not offer any selection of trays.

To change the tray type, close the Xcalibur data system. Then, open the EASY-nLC 
Configuration dialog box as described in “Setting Up the EASY-nLC Configuration” on 
page 10 and select the appropriate tray type.
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Creating Sequences
2. To open the New Sequence Template dialog box, do one of the following:

• Choose File > New.

–or–

• Click the New Sequence icon, , on the toolbar. 

The New Sequence Template dialog box opens (see Figure 12).

Figure 12. New Sequence Template dialog box

For the EASY-nLC 
instrument, you cannot 
change the tray type in 
the Sequence Setup 
view. Tray Type is a 
read-only parameter.
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3. In the General area, do the following:

• Type the base file name for the data files.

• Type a starting number for the value that the data system appends to the base file 
name.

• Browse to select the directory location for the data files in the Path box. 

• Browse to select the instrument method in the Instrument Method box. 

4. Set up the vial or well positions by doing one of the following:

• To use the text boxes in the Samples area of the New Sequence Template dialog box, 
go to step 5.

–or–

• To use the Sample Position Selector dialog box, go to “Setting Up the Injection 
Positions with the Sample Position Selector” on page 40. 

Tip  You can set up the sample positions for a sequence in three ways: 

• In the Samples area of the New Template Sequence dialog box, type the 
number of samples in the Number of Samples box and the starting vial 
position in the Initial Vial Position box. 

• In the Sample Position Selector dialog box, do one of the following:

– Type the number of samples in the Number of Samples to Select box, 
and then click Select (see Figure 14 on page 40).

– Click the positions in the Plate Rack and Vial Rack areas. Use this 
method to set up noncontiguous, nonsequential, or noncontiguous and 
nonsequential positions.
Thermo Scientific EASY-nLC User Guide for the Xcalibur Data System 37



4 Creating and Running Sequences
Creating Sequences
5. Set up the vial or well positions by using the Samples area of the New Sequence Template 
as follows:

• In the Number of Samples box, type the number of samples for the injection 
sequence.

• In the Injections per Sample box, type the number of injections that you want the 
autosampler to make for each sample.

• For replicate sample injections, do the following:

– Select the Re-Use Vial Positions check box if you want the autosampler to make 
replicate injections from the same sample vial or well. Make sure that the vial or 
well contains a sufficient volume.

– Clear the Re-Use Vial Positions check box if you want the autosampler to make 
replicate injections from different sample vials or wells. Load the autosampler 
with a sufficient number of replicate samples.

• In the Initial Vial Position box, type the vial position for the first sample injection. 
For alphanumeric entries, use uppercase letters (see “Run-Time Error Messages” on 
page 44).

6. To set up the remaining parameters in the New Sequence Template dialog box, refer to 
the Sequence Setup view Help.

Note  The sequence editor fills in the Positions column of the sequence table with 
contiguous vial or well locations based on the initial position, the number of samples, 
the number of replicate injections, and the sample selection layout option selected in 
the Foundation Instrument Configuration application.

• Selecting the Row First option in the instrument configuration application 
prompts the sequence editor to fill in the positions row by row (for example, 
A1–A8, B1–B8, and so on).

• Selecting the Column First option in the instrument configuration application 
prompts the sequence editor to fill in the positions column by column (for 
example, A1–F1, A2–B2, and so on).

• Clearing the Re-Use Vials check box prompts the sequence editor to enter an 
additional vial or well position for each replicate. 
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7. Click OK to create the sample sequence. 

The sequence information appears in the Sequence Setup view (see Figure 13).

Figure 13. Sequence Setup view on the Xcalibur Home Page

8. Check the following:

• The vial or well values in the Position column. Make sure that the entries are valid 
and use uppercase letters.

• The numeric value in the Inj Vol column. When the value is –1, the data system uses 
the sample pickup volume specified in the instrument method.

When the Inj Vol column lists a value of –1, 
the instrument uses the Sample Pickup volume 
that is specified in the instrument method.

IMPORTANT      The sequence table contains a column called Inj Vol (injection 
volume). If the column does not appear, choose Change > Column 
Arrangement and add the Inj Vol column to the displayed columns. 

To ensure that the injection volume specified in the instrument method file is 
used as intended, the default value in the Inj Vol column is set to –1, which is an 
invalid injection volume. When the Xcalibur data system detects the invalid value 
during a run, it automatically takes the actual injection volume from the 
corresponding instrument method file, overriding the –1 with the correct value.

During a run, the autosampler draws the specified injection volume (sample 
pickup volume) into the sample loop. The system then flushes the sample out of 
the sample loop and onto the LC column with the specified sample loading 
volume. Specifying an insufficient loading volume can result in blank injections 
or poor injection reproducibility because the system is either not loading or only 
partially loading the sample onto the LC column. 

Changing the sample pickup volume by specifying a different value in the Inj Vol 
column of the sequence does not change the sample loading volume specified in 
the instrument method. To prevent incompatible settings, avoid using the Inj Vol 
column to vary the injection volume. Instead, create different instrument 
methods, where each instrument method contains compatible settings for the 
sample loading and sample pickup volumes (see “Sample Pickup and Loading 
Page Parameters” on page 23). You can use a different instrument method for 
each sequence row.
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Setting Up the Injection Positions with the Sample Position Selector
For information about the parameters in the Sample Position Selector dialog box, see Table 5 
on page 17. The functionality of the Sample Position Selector dialog box depends on where 
you access the dialog box: 

• When you open the Sample Position Selector dialog box from the EASY-nLC 
Configuration dialog box of the Thermo Foundation > Instrument Configuration 
window, use the dialog box to set up the sample layout and initial vial or microplate well 
position for an injection sequence (see “Setting Up the Sample Layout and Start Position” 
on page 16).

• When you open the Sample Position Selector dialog box from the New Sequence 
Template dialog box in the Xcalibur Sequence Setup view, use the dialog box to 
interactively set up the vial or microplate well positions for the injection sequence as 
described in the following procedure.

 To open the Sample Position Selector dialog box from the New Sequence Template 
dialog box and set up the sample positions

1. Click Select Vials in the Samples Area (see Figure 12 on page 36).

The Thermo EASY-nLC Sample Position Selector dialog box opens (see Figure 14). The 
rows for the 6 × 8 vial tray are labeled A–F, and the columns are labeled 1–8. The six 
additional vials in the Vial Rack area are numbered 1-V1 to 1-V6.

Figure 14. Thermo EASY-nLC Sample Position Selector dialog box 
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2. Follow one of these procedures:

• The sequence information appears in the Sequence Setup view on the Xcalibur 
Home Page (see Figure 13 on page 39).To select vials or wells by using the Plate Rack 
and Vial Rack areas

• To select contiguous vials or wells in sequential order by using the Select button

3. To set up the remaining parameters in the New Sequence Template dialog box, refer to 
the Sequence Setup view Help.

4. Click OK to create the sample sequence. 

The sequence information appears in the Sequence Setup view on the Xcalibur Home 
Page (see Figure 13 on page 39).

 To select vials or wells by using the Plate Rack and Vial Rack areas

1. In the Sample Positions (Click on Plate or Select Button) area, click Clear All. 

This clears the Initial Position box and any selected positions on the Plate Rack and the 
Vial Rack.

2. Select contiguous or noncontiguous vials or wells in a sequential or nonsequential order 
by clicking the positions on the Plate Rack and Vial Rack areas in the order that you want 
the samples to be injected. 

Clicking a position turns it green. The first position that you click becomes the initial 
position in the sequence table. The sequence editor ignores the option selected in the 
Sample Selection Layout area and fills in the remaining rows in the order of your 
selections.

3. Click OK to return to the New Sequence Template dialog box.

 To select contiguous vials or wells in sequential order by using the Select button

1. In the Sample Positions (Click on Plate or Select Button) area, click Clear All. 

This clears the Initial Position box and any selected positions on the Plate Rack and the 
Vial Rack.

2. In the Sample Selection Layout area, select either the Row First or the Column First 
option.

3. In the Number of Samples to Select box, type the number of sample vials or wells.

4. Click Select.

The Plate Rack area displays the selected positions in green.

5. Click OK to return to the New Sequence Template dialog box.
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Running Sequences 
After you create a sequence with the appropriate data file names, instrument methods, and 
injection positions, you can run one or more rows of the sequence from the Sequence Setup 
view.

 To run a single sample, a range of samples, or the entire sequence set

1. In the Sequence Setup view, do one of the following:

• To inject a single sample, select the specific row in the sequence table. Then choose 
Actions > Run This Sample, or click the Run Sample icon, , in the Sequence 
Editor toolbar.

• To inject a range of samples, select the samples that you want to inject in the 
sequence table. Then choose Actions > Run Sequence, or click the Run Sequence 
icon, , in the Sequence Editor toolbar.

–or–

• To inject the entire sequence, choose Actions > Run Sequence, or click the Run 
Sequence icon, , in the Sequence Editor toolbar.

One of the following actions occurs:

• If the data system detects a new instrument configuration, the Change Instruments 
In Use dialog box opens (see Figure 15). Go to step 2.

• If the instrument configuration has not changed since the last sequence run, the Run 
Sequence dialog box opens (see Figure 16). Go to step 3.

Figure 15. Change Instruments In Use dialog box

2. If the Change Instruments In Use dialog box opens, do one of the following:

• If the EASY-nLC instrument is not listed as the Start Instrument, click the 
EASY-nLC row in the Start Instrument column and select Yes. Then click OK to 
accept the new setting and close the dialog box.

• If the EASY-nLC instrument is listed as the Start Instrument, click OK to close the 
dialog box. 

The Run Sequence dialog box opens (see Figure 16).
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Figure 16. Run Sequence dialog box

3. Check whether the EASY-nLC instrument is listed as the start instrument in the 
Acquisition Options area.

The Start Instrument column displays Yes for the instrument that triggers data 
acquisition. When the EASY-nLC instrument begins its gradient program, it signals the 
MS detector to begin data acquisition. This signal is transmitted through the contact 
closure cable.

4. Depending on whether the EASY-nLC instrument is listed as the start instrument, do one 
of the following:

• If the EASY-nLC instrument is listed as the start instrument, go to step 5.

• If the EASY-nLC instrument is not listed as the start instrument, make it the start 
instrument as follows:

a. Click Change Instruments.

The Change Instruments In Use dialog box opens.

b. Click the Thermo EASY-nLC row in the Start Instrument column. 

The blank cell now displays Yes.

c. Click OK to accept the new setting and close the dialog box.

Start 
instrument
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5. In the Run Sequence dialog box, do the following:

a. Make sure that the Start When Ready check box is selected.

b. Check the range in the Run Rows box.

c. Click OK to submit the sample run to the acquisition queue.

Run-Time Error Messages
The method editor in the EASY-nLC view of the Instrument Setup window checks each 
parameter entry; however, it does not check for volume conflicts among the entries.

If you have specified an invalid volume for sample loading, column equilibration, or the 
gradient program, an error message appears when you attempt to run samples with the 
instrument method from the Sequence Setup view.

Table 10 lists common run-time errors caused by incompatible settings in the Xcalibur 
instrument method.

Table 11 lists common run-time errors caused by incorrect entries in the Xcalibur sequence.

Table 10. Run-time errors caused by incompatible settings in the instrument method

Message Remedy

Sample pickup flow must be greater 
than 0 when pickup volume is 
not 0.

Enter a nonzero flow rate in the Flow box in the 
Sample Pickup area on the Sample Pickup and 
Loading Page.

Solvent A consumption in the 
method is greater than 120.0 
during precolumn, analytical 
column, and sample loading.

Modify the method so that the total volume for the 
sample loading, the precolumn equilibration, and the 
analytical column equilibration steps is less than 
120 μL.

Gradient: Solvent A consumption is 
greater than 132 μL.

Check the gradient table. Reduce the volume of 
solvent A that is used to produce the gradient.

Autosampler wash flush volume out 
of range:137 (30.25<—>100.75)

For a 20 μL sample loop, enter a volume from 30.25 
to 100.75 μL in the Flush Volume box in the 
Standard Wash area of the Auto-sampler page.

Table 11. Run-time errors caused by incorrect entries in the sequence table

Message Remedy

EASY-nLC devices reported an 
error during the Prepare for Run 
command.

Reduce the injection volume (sample pickup volume). 

The sample pickup volume cannot be greater than the 
sample loop size minus 2 μL, or 18 μL for a 20 μL 
sample loop.
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5

Viewing the Run Status in the Information View

Use the Status page of the Xcalibur Information view to view the run status of the 
EASY-nLC instrument.

 To monitor the run status for the EASY-nLC instrument from the Information view

1. Open the Xcalibur Home Page window as follows:

• From the Processing Setup window, choose GoTo > Xcalibur Home Page.

• From the Instrument Setup window, click the Return to Home Page icon, , on 
the toolbar.

2. If the Information view is hidden, click the Info View icon, , on the View toolbar 
(see Figure 17 on page 46).

3. During a run, click the Thermo EASY-nLC expand/collapse icon to display the 
EASY-nLC run progress and the instrument component readbacks on the bottom portion 
of the Status page. 

4. If the MS detector remains in the Waiting for Contact Closure state during a run, do the 
following:

• Check the contact closure connection between the contact closure pins on the back 
panel of the EASY-nLC instrument and the MS detector’s Start In pins. 

• Check the MS detector selection (with the part number for the appropriate contact 
closure cable) on the Configuration > Connections page of the EASY-nLC 
touch-screen application.

Figure 17 shows the Status page for an LC/MS system with an EASY-nLC instrument and 
an LTQ XL™ MS detector. The EASY-nLC instrument is loading the sample onto the column 
assembly and the MS detector is waiting for the contact closure signal from the 
EASY-nLC instrument.

Note  The Qual and Quan Browser windows open in front of the Home Page 
window.
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Figure 17. Status page of the Information view

Info view icon

Expand/collapse 
icon

Run-time steps for 
the EASY-nLC 
instrument 

During a run, the MS detector remains 
in the Waiting for Contact Closure state 
until the LC instrument sends the 
start data acquisition signal.

Status of the 
instrument 
components
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